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INTRODUCTION

Accucadd

This tutorial provides a “hands-on” introduction to Accucadd. It deals with features
and functions common to all releases of the product. In some instances, functions
may behave differently based on the specific version of Accucadd in use. In such
cases, version differences will be noted.

We hope you enjoy using Accucadd!

Many man-years in development, Accucadd is a fourth generation system offering
you an entirely new approach to technical design. The exercises in this tutorial were
selected to make your transition to Accucadd remarkably easy, yet provide a solid
grounding in important features and techniques.

If you have comments or questions about our product, we invite you to call your
dealer or Robo Systems direct. Thank you for choosing Accucadd.

New features ...

Because Robo Systems has a policy of continuous product enhancement, your
software may differ in detail from that described herein. Since this Tutorial is
designed to provide an introduction to the main features of Accucadd, it does not
cover all the features and functions of the software.

You can begin drawing with Accucadd in less than 20 minutes ...

Creating technical drawings on a personal computer used to be a heavy exercise in
computer programming, suited only to the specialist prepared to invest weeks in
learning a whole new syntax, and a host of unfamiliar commands.

Accucadd is different. Instead of computerese, it uses graphical symbols, and its
unique command structure allows you to “talk to it” in a casual, unstructured way -
quite unlike the rigid protocol imposed by other CAD software. It works with you, too,
guiding and prompting in a friendly, interactive style. Now, with Accucadd, you can
sit down - right now - and start designing almost immediately.

All you have to do is follow the simple steps of this Quickstart Tutorial, and you will
see how to handle a range of design tasks, from basic drawing to complex
schematics, and from simple sketching to dimensioned drawings. You will see, too,
that Accucadd is much more than a drawing system; it is a design tool that helps
develop your product from first thoughts to precise engineering data at truly
remarkable speed.
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GETTING STARTED

Accucadd Software

Accucadd software, including the Evaluation version, is freely copyable. You are

recommended to make a back-up copy of the compact disk (CD) before using it for

the first time. Store the original Accucadd CD in a safe place, in case it is needed

again - which will not occur unless the working copy becomes corrupted.

A WORD ON COMPACT DISKS (CD) ...

In general, CD are reliable and durable. You can help keep them that way by careful

handling:

� Handle only by the center hole and extreme edges.

� Never touch the main surface of the disk itself.

� Keep diskettes away from dust, grit, smoke, and anything else likely to
contaminate the surface.

� Return disk to its protective case or sleeve when not in use.

� Keep CD away from heat and liquids.

� Keep in mind that the one time you get careless is the time you lose a
few bytes from a critical folder, destroying hours of creative work.

A WORD ON WINDOWS ...

Accucadd, like most other programs running on your computer, makes use of

Microsoft Windows. Windows is the computer’s housekeeper, the essential

interface between the computer hardware, applications software, and data files

stored on your disk drive.

Commercial applications programs, Accucadd included, go to some lengths to

conceal the computer’s inner workings, and you can use them without knowing the

first thing about Windows. However, mastery of basic Windows operations, such as
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disk formatting and file copying, can give you a great deal of independence. The

User’s Help included with Windows is a good introduction. Several Windows

primers are also available from your local bookstore.

Throughout the tutorial, the square brackets [] signify an action or procedure

you should try for yourself.

When you first receive Accucadd you will need to install the software. Simply insert

the CD in your CD drive. The installation program will usually start to run

automatically within a few seconds. If this does not happen, you can use Start:

Settings: Control Panel: Add/Remove Programs, or you can use Start: Run...

Browse to your CD drive, and then run the installation program (setup.exe), or you

can do the same thing in Windows Explorer. If this is a first time installation, accept

the installation program’s suggested settings. If this is not a first time installation, be

sure you have backed up your library before proceding to ensure that the new

extended library does not overwrite any work you wish to keep.

The following assumes a configured, operational system, with Accucadd installed in

the suggested folder C:\Program Files\Accucadd.

Running Accucadd

You will have one or more of the following ways to start Accucadd:

• A “shortcut” to Accucadd on your Desktop - double-click to run Accucadd

• An entry for Accucadd in your Start Menu - click to run Accucadd

• An entry for Accucadd in the Start: Programs Menu - click to run Accucadd

• Or, you can browse to the folder C:\Program Files\Accucadd and double-click

Accucadd(.exe)

When the Accucadd files have been read from the hard disk, you will be asked if you

want to load the previous drawing–click “No”. The blank work area appears as

shown below. Your Accucadd system is now ready for use.
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MAKING MENU SELECTIONS

The main menu titles, such as Set Up and Draw, run along the top of the screen. The

palettes at right contain icons depicting various types of drawing element, line type

and line weight. The cursor is a + marker (not shown below).

[] The cursor follows movements of the mouse (or digitizer stylus).

To select an item from a menu or palette, simply point-and-click–push the left-hand

mouse button. (With a digitizer tablet, you “click” by gently pushing down on the

stylus, or (in most cases) any of the buttons on the puck.)

To cancel a menu selection, press the Esc (escape) key, or simply make another

selection. The right-hand mouse button (or a second button on a digitizer puck) can

usually be used to cancel menu selections, too.

Throughout this tutorial, the word “touch” means “point-click left button”
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[] Touch Set Up on the main menu. This displays the Set Up menu as shown below.

Note that the + cursor changes to a pointer when in menu territory.

[] Touch Paper on the Set Up menu. A “pop-up

window” appears, inviting you to select from a

number of different paper sizes. This sets the “size”

of the “piece of paper” that you are drawing on. For

now, simply press the Esc key to exit the function.

If you move the mouse too quickly you may find you

are getting the “wrong” menu entry. This is

because Windows looks at the menu entry under

the cursor when you release the button, not when

you press it. Make sure the cursor is still over the

selection you want when you release the button. If

the Orth Trap is not displayed on your screen, move the cursor to the Toolkit menu

and touch Orth Trap. Additionally, make sure the elements palette is displayed and

line is selected as shown in above. The Elements palette is displayed if you touch

the Elements command in the Draw menu.

The dotted lines passing through the screen center belong to the Orth (ogonal) trap,

which was pre-selected for you from the Toolkit menu. Away from the trap lines, the

cursor moves freely about the screen. Close to a trap line, the cursor seems to fall

into a groove, and now prefers to move only along the line. We use this feature to

draw precise horizontal and vertical lines.

[] Move the + cursor to the screen center; when approaching the center, it snaps

into position, as though magnetized. Now touch the center point to “plant” the

cursor, marking the start of a line.

The cursor is now tethered to the datum by a “rubberband”, which shows you how

the line will appear when you confirm it. This visual feedback of length and position

allows you to experiment freely, without actually drawing the line.

[] Keep an eye on the dimension display at the bottom of the screen, move the +

cursor vertically up from the triangle about 3 in., then “touch” to draw line (1), as in

Figure 3.

To draw line (2), we need to shift the datum to the top of line (1). This is very easy with

Accucadd, because end-points are automatically snap points (“magnetic points”)

unless you choose otherwise.
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[] Snap the + cursor to the top end of line (1), then touch to set the new datum

there. Notice that the Orth Trap has “updated” (moved to the new datum).

[] Move the + cursor about 4" to the right, along the trap line, then touch to draw

line (2) to make an L-shaped figure.

Our next “data entry” - the line we are about to add - turns the “L” into a triangle, but

before that, you might try turning off the Orth Trap. You don’t have to do this (some

users leave it on most of the time), but it’s a good idea to practice.

[] Touch the word Orth (below Toolkit) to cancel the trap. This may leave holes in

the lines you drew. This is only a display effect, having no affect on the quality of

printed hard copy. you can repair the image by selecting Redraw from the VIEW

menu.

[] Move the cursor to the free end of one of the two lines; again, as you approach

the target, the cursor snaps precisely into position. Plant the cursor there (touch),

then head for the other line-end. Snap the cursor there, then touch to draw line

(3), as in Figure 4.

Use the Esc key to free the cursor, if you find you’ve planted it in the wrong place.

Esc, repeated as necessary, can get you out of most situations or procedures you

don’t like the look of. If in trouble, think Escape.

A FEW WORDS ON DISPLAY RESOLUTION...

In the context of CAD, this means the ability to display detail. Your video display is a

mosaic of thousands of tiny cells, called pixels, which are individually controlled by

the computer’s display processor, or “graphics card”. The more pixels per square

inch, the better the resolution. With a common setting, your display has 800 pixels

horizontally, and 600 vertically. Looking closely, you will see that orthogonal lines

(true horizontal and vertical) display perfectly, whereas all other lines - and arcs - are

uneven, or jagged. This is strictly a display effect, having nothing to do with the

accuracy or quality of the drawing, as you will see from the printed examples later.
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You’ve seen how Orth helps make a neat job of freehand sketching, with true

horizontal and vertical lines. It can also be used with numerical data entry, from the

keyboard, to draw lines precisely to length.

[] Turn on the Orth trap, by touching the word Orth again. Touch any point (4) on

the work area, as Figure 5, to set the start (datum) of a new line there.

With numerical data entry, you simply point the way, then let the system decide how

far to go.

[] Move the + cursor left along the trap line, then key in 3.1875 followed by Enter

to draw the line to the exact length.

You will have noticed that the first number key pressed brings up a “window”

displaying whatever you key in. This applies to all actions where numerical data

entry is required or optional.
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[] Touch the left end of the horizontal line. Point the cursor down the trap line,

then key in 2.5625 followed by Enter.

DRAWING PRECISION...

We have been working to four decimal places, but you may enter more digits if you

wish. However, drawing with greater precision than the job needs is a waste of time.

What you are aiming for in most cases is a representational drawing, serving the

same purpose as those “hand drawings” in days gone by (and how precise,

physically, were they?). In such a drawing, the dimension labels are more important

than physical appearance. You will need to pay more attention to precision if your

drawing is to be an actual dimensional reference, for example, in architecture, or

direct control of machine tools (CNC). Regardless of what you set the displayed

precision to, Accucadd works to better than 16 digit precision internally.
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[] Draw a line 3.1875" to the right, then complete the rectangle, as Figure 6, using

“magnetic points”. Just touch one line-end, and then the other.

Since magnetic points are so useful, most users leave them active at all times.

Occasionally, you may wish to deactivate them:

[] Unless you removed it by accident, the Points palette should be displayed at

bottom left of the screen. To “demagnetize”, click the top icon (point and click). To

“magnetize”, click it again. If the palette is missing, retrieve it by selecting Points

from the Toolkit menu.

Within the drawing area, snap points and handles are denoted, respectively, by tiny

rectangles and triangles. You can reduce clutter by turning off the symbols, which

you don’t need most of the time.
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[] Click the “points displayed” icon on the Points palette. This is the second icon

from the top of the Points palette. Although the markers have disappeared, the

end-points are still magnetic “snaps”.

A third icon on the Points palette is used to locate intersections. This function is

described in a later example. Two more icons on the Points palette represent the

“midpoint find” and “update snaps” functions. Refer to the Accucadd Reference

Manual for additional details.

Throughout Accucadd, a “pushed-in” button means “YES / GO / ACTIVE”, and a

“released” button means “NO / STOP / INACTIVE”. Active selections are also

highlighted in yellow.

EDITING THE DRAWING

So far, we have used Esc to give us a second shot if we planted the cursor in the

wrong place; in fact, you can use Esc to break any action sequence, such as keying

in numerical data. However, once you have committed yourself by drawing

something, it’s too late for Esc; now, you need to edit the drawing:

[] Steer the cursor to any corner of the drawing. Snap it into place, then draw a

line - any line - from there to some other point on the screen (arrowed in Figure 6).

[] Select the Edit menu, as in Figure 6. Select Undo, and the line disappears.

You could have used Erase instead, but Undo is the faster way of removing the last

line drawn. (Undo actually does more than remove the last entry; it restores the

system controls to their previous condition.) Erase lets you remove any line,

regardless of when it was drawn.

[] Draw another “unwanted” line, just like the one you “undid”.

[] Select the EDIT menu, then select Erase.

Examine the Erase palette shown in Figure 7. There are several element selection

methods. Select whole item, as shown. Make sure that visible tagging is also

selected. These same selection techniques are used for the Change, Move, and

Copy commands. Make sure you are using whole item with visible tagging as in

Figure 7.
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Steer the rectangular “whole item” cursor over the element to be removed, then

touch to confirm. The line is tagged with end markers and a cross. Tag more lines if

you wish.

If you change your mind, and don’t want to remove that line, trap it again (touch) to

remove the markers. This procedure is called “de-selection”; it also applies to other

functions on the Edit menu, such as Change.

[] Remove the line by touching the large check on the Erase palette. Exit the

Erase function by touching the “cancel” symbol, [C]. Touching [C] before the

large check mark will exit Erase without making any changes.

Throughout Accucadd, [C] means “cancel”, or “abort”
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HOW TO CLEAR THE SCREEN IN ONE GO...

Edit: Wipe will clear your drawing. You can not Undo a Wipe, so you will always be

asked to confirm.

Wipe permanently removes all elements of your drawing, without affecting the

system controls (Paper size, units, scale, and so on).

PAPER SIZE, UNITS AND SCREEN DIMENSIONS
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Newcomers to CAD are often perplexed by the relationship of “real- life” dimensions

and screen image size. When we ask you to draw a 4" square, that’s exactly what the

CAD system records internally. However, only by pure chance will its screen image

measure 4", because this depends on uncontrolled variables such as monitor size,

and the scale factor you specified. The other point to ponder is the size of the printed

drawing. In most CAD work, you will want the print itself to be an exact measure of

the object depicted - scaled up or down, of course, depending on the application,

and size of printer paper chosen. Accucadd keeps all these variables under control

in a unique way.

First you choose Units, which can be any popular English or Metric selection. Next, you

choose one of 14 ANSI or ISO Paper Sizes (or specify one of your own). This redraws

the work area on the screen to match. Your choice of paper size is reported at right of

the “status line” along the bottom of the screen. Finally, you choose a Scale to fit the

object you wish to draw within the paper boundary; for example, a scale of 1:10 would

allow you to draw a figure 100" wide on an A-size sheet (11 x 8-1/2).

“What you see is what you get”

With Accucadd, as you develop your drawing, you can see at a glance how it will

print on the chosen size of paper; this is because the ratio of print-to-paper is exactly

the same as screen image-to-work area.

Q: I have an A-size printer; suppose I started out with a scale of 1:10, giving me a

100" wide work area, and it turns out I need 150" ?

A: Change the scale to 1:20 (or a scale of your choice). You could select a larger

paper size (B-size, 11 x 17, would do), but since your printer can’t handle it, you will

not have “what-you-see-is-what-you-get” operation. Whichever you choose, the

screen image will be redrawn (smaller) in correct proportion to the new work area,

but the object’s real dimensions do not change. These are absolute values, tablets

of stone! 100" is still 100" to the CAD system, even though the display is half its

original size.

[] Wipe the screen, then sketch any simple figure to fill the A-size work area, as

shown in Figure 8.

[] Select Paper Size from the Set Up menu and select C. The status line now reports

22 x 17, and the aspect ratio (width: height) of the work area has altered accordingly,

as in Figure 9.
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[] Return to A-size paper, then select Scale from the Set Up menu. Key in 1:2,

then press Enter. The status line reports the new scale, and image is redrawn at

half size.
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METRIC AND ENGLISH UNITS

You can experiment with the various units available in Accucadd:

[] Select Units from the SET UP menu (or from the status line).

The table now displayed lists two classes of units, “specific” and “generic”. The

specific units are mm, m, km, 1/64", inches, feet (‘), and miles. Selection of one of

these forces the system to work only in that specific unit, and decimal fractions of it

(except 1/64", which works in inches to the nearest 1/64). The generic modes,

ENGLISH and METRIC, allow the system to choose the most appropriate form of

display and data entry. For example, in the ENGLISH mode, a length 12" or greater

will display as feet, inches, and fractional inches:

[] Select Paper Size, then D; now select Units, ENGLISH.

[] Touch any point (set datum) near the left edge of the work area, then move

away to the right.

You will see that the dimensions display reports in inches and fractions of an inch up

to 12, then converts to feet, inches and fractions. The “size” of the fraction is set by

the Set Up: Precision menu. It can range from whole inches (no fractions) to

1/64inch. Now try entering a line length using the same convention:

[] From any datum point near the edge, give the rubberbanded line a direction by

pointing it toward the center, then key in:

[2][‘][3][SPACE][31][/][64][ENTER].

(SPACE means “press space bar”). This will draw a 2’- 3 31/64" line, in the

chosen direction.
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DRAWING PROJECT 1

In Accucadd there are many precision drafting tools, such as the Orth trap, which

gives you perfect horizontals and verticals. Snap grid is another useful device for

organizing the work area.

[] Wipe the drawing page (select Edit: Wipe).

[] Select Grid from the Toolkit menu. This will turn off Orth if it’s on.

You can configure the grid palette, Figure 10, to suit your exact needs. For now, use

the preset “default” settings.
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In some cases, the initial settings for various functions may not match the

tutorial. Simply change them before proceeding. In most cases, this means

touching the numerical value on the palette and typing in the desired value.

Use the Save Setup feature, if desired, to make the new values the start up

settings.

[] Make sure the right-hand grid is selected, then turn it on by touching the check

symbol.

The cursor is no longer free to roam around the screen. Instead, it jumps (“snaps”)

from point to point in 0.25" increments. (You can steer it between points: it snaps to

the grid when it’s within the Trap Zone--see Set Up: Snaps).

[] Draw a rectangular box 6.0" x 2.5"., as Figure 11. It need not be centrally

positioned. To start a line, touch a chosen snap point to set the datum, then move

out to the desired end-point, while keeping an eye on the dimension display.
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Touch to draw the line. If you find you have set the datum in the wrong spot, use the

Esc key to free the cursor, then try again.

Next, we draw a circle in the center of the rectangle. With the grid in place, this is very

easy to locate:

[] Touch the top left corner of the rectangle. Move 3" to the right, hold the pointer

there, then press Esc. If you haven’t moved it, the cursor will still be “snapped” to

the same spot.

[] Touch the spot to make that the new datum, move 1.25" down to the center of

the rectangle, then press Esc again. You may wish to mark the center with a

short line, which you can later erase; don’t bother with this if you have a good

mental image of the center location.

[] Touch the circle icon from the “elements” palette, as Figure , then touch the

center of the rectangle. Now, with its center established, the circle can be

expanded to the desired diameter simply by moving the + cursor on the
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Figure 12: Adding a circle



circumference. Using the snap grid (and dimensions display), set a 3" diameter

circle, then touch to draw.

The center of the circle is itself a “magnetic” snap point, just like the end-point of a

line. This means you could draw concentric circles even if the grid were turned off.

Check this by turning on Points, as in Figure .

A more flexible way of drawing a circle, with or without a grid, is to set its center, then

key in the diameter:

[] Set the center of your next circle in the same place as before (touch). Key in

2.625, then press Enter to draw. (See Figure 12)

In addition to the one you just drew, there is now a “free” circle you can move around

(press Esc to cancel it, but not now); you could, if you wish, draw any number of

2.625" diameter circles all over the screen, without respecifying their dimensions.

(Don’t do it now, but remember this for the next time you want to set out a number of

bolt holes in a plate.) Here, we need three more circles concentric with the first.
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[] Steer the “free” circle back to coincide with the fixed one you just drew; hold it

there while you key in 2.25, then press Enter to draw.

[] Draw 0.75 and 0.50" circles in the same way - hold the pointer at the center, key

in the diameter, then Enter to draw.

[] Turn off the grid by touching the x symbol on the grid palette, then remove the

palette itself by touching the [C].

Now we want to take a closer look at the drawing - or a portion of it - so we magnify it

using Zoom.

[] Select View, then Zoom. The + cursor, which is going to be the center of the

zoom window, is “snappable”, just like the regular drawing cursor. Snap it to the

center of the circles, then move away. The rectangular window marks the area

that will be enlarged to full-screen when you execute the zoom.

The magnification is reported continuously by the dimensions display.
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Figure 14: Zoom window set for 2x magnification



[] Set the window so that it just encloses the area of interest, then click to execute.

Alternatively, you can set the magnification precisely by keying in a numerical

value, followed by ENTER, as in Figure 14.

Part Erase, a powerful editing facility, is similar to Erase except that it automatically

recognizes intersections, and doesn’t go beyond them. (As you saw earlier, Erase

removes entire elements.)

[] Select EDIT, then Erase.

[] Make sure the Part Erase icon is selected in the upper right of the Erase palette

as shown in Figure 15.

[] Place the rectangular “trap” cursor over the larger circle, where it extends

beyond the rectangle, as Figure 15. Click to confirm; the selected portion is now

tagged with end markers and a cross. Tag the other protruding segment at the

bottom of the rectangle in the same way, then execute by selecting the check

symbol (on the Erase palette).
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Figure 15: Part Erase “trap”



If you make a mistake and select an element you do not wish to erase, simply

touch on the same element a second time. This will “de-select” the element.

This same method of de-selection also applies to the Change, Copy, and Move

commands.

[] Still in the Part Erase mode, chop out all segments of the rectangular outline

within the outer circle, as Figure 16.

[] Exit Erase by touching the [C].

Now, instead of removing an element, we can change its appearance. This is done

using the Edit:Change command. This command allows you to change an element’s

line weight, line type, color, or layer.

[] Select Edit, then Change. We will change the outline of our part to line weight 2.

To use Change, we must first select the elements to Change, then tell the system

what to change about the selected elements.
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Figure 16: Segment removal using Part Erase



[] Select every element of the outline (which is now in two halves) for change as in

Figure 17 and touch the check symbol. (The selection markers will no longer be

displayed.)

[] Select line weight from the change palette, and select line weight #2 as in

Figure 17. Touch the check symbol to execute the change.

Experiment by changing other elements, e.g., the outer circle to line weight #3. You

can change it back to #1 if you wish.

[] Reselect line weight #1, then touch the line type icon. Select line type #5, and

apply that to the inner circle. Exit the change mode by touching the [C].

[] Select View, then Redraw. This replays the drawing at its original size, but now

with the amendments you made in Zoom.

[] Select line mode from the elements palette.
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[] Select Snap Grid from the Toolkit. Before switching on the grid, touch any

corner of the rectangle. This serves as a reference location (datum) for the grid,

which we want to display in exactly the same position as before, relative to the

drawing.

TWO DIFFERENT SNAP GRIDS...

Both grids on the palette have adjustable spacing, and different spacings may be set

for the horizontal and vertical “axes”. The left hand grid id fixed in position--the

“origin” is at the screen center, and marked with heavier lines--and also fixed in

orientation. The right hand grid is fully programmable, which means you can also

change position (origin), and the alignment of its axes. (If you touch any of the

numerical displays on the palette, you will be invited to key in a new value.

Experiment if you wish, but return to the original settings before proceeding.)

[] Switch on the right-hand grid by touching the check on the grid palette. (If the

grid doesn’t coincide with your drawing, touch the x to turn it off, set its datum,

then turn it on again.)

[] Select line type #1, and weight #2, to match the rectangular outline.

[] Touch the 3-point arc icon on the elements palette, as Figure 18. Plant the first

point two grid units (0.5") down from one of the top corners of the rectangle, and

the second point two units up from the corner below it. Set the + cursor on the

“rubberbanded” arc to give a symmetrical concave surface, 0.25" deep, then

touch to draw the arc, as shown at the right-hand side in Figure .

[] Repeat at the other end of the figure. Erase the chord from each arc using

Erase - part item.

[] Select Draw, then Fillet. Set the fillet radius to 0.25"; touch the numerical

display [r], key in .25, then press Enter.

[] Zoom x2 to get a closer look, as Figure 19. “Trap” line (A), by planting the

rectangular cursor over it (anywhere will do), touch once, then do the same thing

with the adjoining line (B). This displays a full circle, which you can drive around
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to display the several possible fillet locations. Choose the inboard one as shown,

then touch to draw the fillet.

[] Fillet the other three corners in the same way. Set the fillet radius to .125, then

fillet the four “horns”.

[] Use Part Erase to trim the filleted corners, as Figure 19, below.

In Accucadd, you can also use the automatic fillet trim feature to avoid having

to trim the fillets with Erase. The fillet trim icon is part of the Fillet palette.

PALETTES IN THE WAY?

Move the elements and line-type palettes out of the way by snagging them with the

“hand” symbol, which appears as you just move into the palette top area (gray bar).
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Figure 18: Three-point arc



Press and hold the left mouse button, drag the palette to where you want it, then

release the mouse button.

ZOOMING AROUND...

Sometimes, you will find yourself shuttling from a zoom view to the full-page view,

then back again to the same zoom view. You can save the trouble of setting up the

zoom window each time by using the save zoom feature. When you are through

working on a zoom view, select View, then Save Zoom. Save the view by touching

any of the 16 listed memory locations. To recover the view, select View, then Load

Zoom by touching the same spot on the memory list. You can also name the views to

help you remember what they are. Another trick you can use in zoom is to shift your

point of view, as though you were roaming around with a magnifying glass - useful

when the feature you need is just off-screen. Once in the zoom view, select View,

then Pan. Touch any point in the work area with the cursor, then indicate with a

second touch where you would like that point relocated; Pan is then executed,
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Figure 19: Filleting of lines and arcs
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drawing a fresh zoom view with the same magnification as before. You can also use

the Windows scroll bars, and if you have an Intellimouse, you can use its pan

functions.

[] Select VIEW, then Redraw the base view.

[] Select DRAW, then Hatch.

There are eight basic hatch patterns. However, since each of these can be drawn in

eight line weights, and eight line types, there are several hundred to choose from. As

you can also change the pitch (line spacing) and the color, too, there is actually

almost an infinite variety.

The pitch we’ll use is 0.15". Touch any of the numerical displays (.15"), and you will

be invited to key in a new value, followed by Enter. Experiment if you wish, but

restore the top two patterns to 0.15.
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Figure 21: Defining an area to be hatched



Hatch will fill any closed area defined by any combination of lines, arcs (including

fillets), circles and curves .

[] Select line weight #1; then, with the default pattern (top left) selected, plant the

hatch “seed” by touching any point within the boundary at left of the drawing.

[] Now define a rectangle which fully encloses (but only just) the area to be

hatched (the idea of this is to cut down on processing time by rejecting as much

of the work area as possible). Touch to plant the first corner of the rectangle, then

move away to expand the window, as Figure 21. Touch the opposite corner to

execute the hatch. Use Esc to free the cursor if you get it wrong the first time.

[] Select the top right pattern, then hatch the opposite boundary. Exit the Hatch

mode by touching the [C] on the hatch palette.

We are just about ready to save your drawing in the library, marking the end of this

first project, but first we need to add two center lines and a title. In some versions of

Accucadd, the text parameters are reported in fractions of an inch, not decimals.

Your version may display ¼ rather than 0.25 – this is not an error.

[] Select Redraw to display the base view, then select Snap Grid. Touch the

center of the circles to set datum for the grid, then turn on the right-hand (0.25")

grid.

[] Select line type 7, then draw two center lines 1" in from each end, as Figure 22.

[] Select Text from the Draw menu; then 1n the Text Editor window, type

“Experimental drawing”, or some other title.

[] Return to the drawing page by clicking the OK button; position the rectangular

cursor - which is carrying your label, invisibly - under the drawing, then touch to

draw, as Figure 22.

You will notice that the bottom left corner of the text cursor is a snap point. (If you

ever need to, you can turn off the grid for finer control of position.) The text palette is

displayed below.

Note that we use the word “draw” for text. The text label is composed of a series of

arcs and lines, drawn in the usual way, with any line weight of your choice.

In Accucadd, 26 different text fonts are available (default is Simplex) with adjustable

character slant.
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[] Touch the line weight icon on the text palette, then select weight #2.

[] Position the text cursor, still carrying the same label, below the previous entry,

then touch to draw.

[] Go back to line weight #1, and set the character slant to 15 degrees as in Figure

23, then add a third text label beneath the other two.

[] Change the text height by touching the numerical display (default value .25"),

then key in 0.375 followed by Enter. (Note: 0.375 may be reported as .38

depending on the Precision setting under Set Up.)

[] Add the fourth text entry, as Figure 23.

[] Before saving the drawing, you may wish to remove all but one of the text

labels. Select Erase; this displays an inverted triangle beneath each text label.

To remove a label, tag its “T” handle by touching it with the “trap” cursor, then

touch the check symbol to erase, in the usual way.
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Figure 22: Adding a text label



A powerful feature of Accucadd is its ability to make, and edit copies of a text label

without having to retype the whole thing. For simplicity, the editing capabilities of the

different versions of Accucadd are described separately. We do recommend ,

however, that you read each section because of backward references in the text.

EDITING TEXT WITH Accucadd ...

[] Select Text from the Edit menu, and select a text entry by touching its tag; this

redisplays the label on the Text Editor window.

[] Edit the text in the usual way; position the cursor with the left/right directional

arrows, then key in new material (the “old” text moves right to accommodate the

new). Use the Del key to delete characters, left of the cursor, one by one. If you

wish to change only the style, height, or weight of the label, just return to the

drawing area as directed below.
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Figure 23: Changing text style, weight, and height



[] Return to the drawing page by clicking the OK button. Make any changes to the

Text palette, position the text cursor in the desired location, then touch to draw

the text.

Anytime you have a text cursor active on the drawing page, press the F3 function

key to redisplay its contents in the text editor.

Text Editing functions

[] Select Edit - Text. This displays a palette with the options to Copy, Replace,

Move, (change the) Font, or Change (the other text properties). Select Move and

choose the Text to edit. This will place the text in the text cursor. Anytime the text

cursor is active on the drawing page, the first 30 or so characters of the text will

be displayed in the staus bar.

[] Press the F3 function key to place the text in the Text Editor. Anytime the text

cursor is active on the drawing page, F3 places its contents in the Text Editor.

[] Edit the text.

[] Return to the drawing page by clicking the pointer button, make any change to

the Text palette, position the text cursor, then touch to draw the text.

The Text editing capabilities are described briefly below:

Copy copies the selected text entry into the editor and allows access to text

attributes before planting.

Replace copies the selected text entry into the editor for alteration, then places the

altered text at the same point with the same attributes as the original text.

Move displays the text box and allows access to the text attributes.

Font allows you to change the font of existing text.

Change displays a dialog which allows you to select, and change, one or more of the

following text properties:

Height, Line spacing, Character spacing (spacing between one character and

the next), Character slant (”italics”), Rotation (of the entire block of text), and Line

weight.

Accucadd Quickstart

Page 1-16



Now we come to an important operation in the CAD process - saving the drawing so

that it can be worked on later. This operation is called “filing in the library”, or “saving

to disk”.

[] Select File from the LIBRARY menu.

A library index of pre-drawn material is now displayed, e.g. Figure 24. (See the

Reference Manual if you are creating your own library disk from scratch). This index

is a unique feature of Accucadd. It is a visual catalog of library contents, displayed as

micro-images. This eliminates the need, when filing a drawing, to assign it a file

name or number (which, if you don’t make careful notes, there is a chance of your

forgetting, or worse).

The “box” size is adjustable, and you should select a size large enough to display an

identifiable image. For a small component drawing, such as a schematic symbol,

the default box width of 4 units (or less) is fine. Try changing the size to 8 units:
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Figure 24: Library index, with Project 1 filed at bottom right



[] Touch the numeral 8 on the “size table” at right. This doubles the width of the

rectangular cursor. Change it back to 4 units.

Box size has nothing to do with file size. There is nothing to stop you assigning a

small box to a drawing with hundreds of elements. The file will be intact, but you wont

have a recognizable micro-image.

[] Steer the rectangular cursor to the bottom right corner of the page (or any other

free space you wish), then touch to execute the filing process.

You will be prompted to Move (reposition drawing before filing), Add label, or Exit

(which means return to the drawing screen); you must do one of these.

[] Select Add label.

The Text Editor window appears, prompting text entry in the usual way - but keep it

short, e.g. “Project #1". Click the pointer button to enter the label, as Figure 24. Note

that this label is not a filename recognizable by the computer. It is only information

added to avoid confusion in cases where there are several similar micro-images.

What is filed in the library is always the complete, unzoomed drawing (the “base”

version), regardless of the view you had on the screen when you selected File.

With your drawing safely filed away, you can end the work session.

[] Select Exit from the File menu. If you get the “Save Settings On Exit” dialog,

touch Cancel. When you get the Exit dialog “Data will be lost … Exit?” respond by

clicking the “Yes” button. This dialog is a reminder to save your work, if you have

not already done so.

THERE ARE OTHER, FASTER WAYS ...

You’ve seen how a snap grid can help organize the work area, and get things going

fast. With a grid in place, try a new kind of drawing element - the rectangle. The

rectangle icon is shown in figure 25, which identifies all the drawing elements.

[] Touch the rectangle icon on the elements palette, Figure 25 (below).

[] Plant the first corner of the rectangle by touching any snap point on the grid,

then move away to expand the figure.

[] Snap the opposite corner into place, then touch to draw the rectangle.
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Drawing Project 1 started with a 6" x 2.5" box,

which happened to fit nicely on the default

snap grid. But suppose the dimensions were

not so convenient (i.e., more realistic), such

as 6.125" x 2.938". No problem; you can

handle this in many ways.

ORTH TRAP METHOD

[] Wipe the system, select Orth Trap and line

mode, then touch the spot you wish to be the

top left corner of the rectangle.

[] Point the cursor right, along the trap line,

then key in 6.125, followed by Enter.

[] Touch the right end of the line you just drew,

then point the cursor down; key in 2.938,

followed by Enter.

Complete the rectangle, then locate its center:

[] Touch the top left corner again, point to the right, then key in 3.0625, but don’t

Enter; instead press F11, which transposes the datum without drawing a line.

[] From the new datum, point the cursor down, then key in 2.938 / 2, followed by

F11. You now have a solid location - the trap intersection - to plant the circle.

Any time Accucadd asks for numerical data, you may enter expressions with a mix of

addition [ + ], subtraction [ - ], multiplication [ * ] and division [ / ], in any order (with

attention to the usual rules of algebra, please). You can use parentheses [ ( ) ] to

clarify the expression.

DELTA METHOD

[] Wipe the system and select line mode, if it’s not already active. Orth Trap is

optional.

[] Touch any point in the approximate center of the work area, making that our

reference location, i.e., datum.

[] Press the F6 function key. Throughout this tutorial, this action is referred to as

Delta.
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This activates Accucadd’s Delta coordinate entry. It invites you to enter a pair of

coordinates to which the datum will be shifted. We use the standard convention,

where Y increases as the cursor moves up the screen, and X increases to the right.

The objective is to draw a 6.125" x 2.938" rectangle, symmetrically placed relative to

the datum you just established:

[] Key in the X, Y coordinates of the top right corner: 6.125/2, 2.938/2. Now press

F11 to shift datum.

[] Select Delta, then the coordinates of the top left corner, relative to the new

datum: -6.125,0. This time press Enter to draw a line and shift the datum.

[] Touch the left end of the line, key Delta, then key in the bottom left corner:

( 0, -2.938 ) followed by Enter.

[] Draw the third side in the same way. The fourth side, of course, you can snap

from one end-point to the other, without typing anything.

POSITIONING A CIRCLE

You can also use Delta to plant a circle relative to a datum. (This works equally well

with compass arcs.)

[] Still in the line mode, touch the top left corner of the rectangle to set the datum

there, then select the circle icon from the elements palette.

[] Key in the coordinates of the center of the rectangle: 6.125 / 2, -2.938 / 2, then

press Enter. This shifts the datum, and fixes the center of the circle, so all you

have to do now is key in the diameter in the usual way.

MAKING AN INTERSECTION A SNAP POINT

Here’s a neat way of finding the center if you don’t know the rectangle’s dimensions.

[] Wipe the screen and draw any rectangle.

[] Select the line mode and draw two diagonals.

[] Select Points from the Toolkit menu, then activate the “intersection locator” by

touching the check symbol as Figure 26.
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[] Touch the intersection of the diagonals with the trap cursor, then deactivate the

“locator” by touching the X.

The intersection has become a snap point, just like any other element on the

drawing. You can locate more than one intersection at a time - just go around with

the trap cursor, touching each one in turn. The intersecting elements themselves

can be erased without affecting the snap points.
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DRAWING PROJECT 2

For this project you will need the drawing you saved at the conclusion of

Project 1.

Imagine that you were just about to Load your drawing back to the screen, when you

recall you had forgotten to draw six screwheads, all exactly the same... Well, with a

CAD system, you never draw the same thing twice, so we draw one screwhead, file

it, then use it six times. First, we need to change paper size - small drawing, small

paper. It would be just as easy to use the A-size paper, zooming to add detail.

However, when filed, the micro-image of your drawing would be so small - a dot in a

blank field - that you wouldn’t be able to identify it without a label.

[] Wipe the screen, then select Paper Size from the Set Up menu. Now select

“Set User” from the table of paper sizes; for width, key in 0.5” Enter, followed by

the same for height.

User defined paper sizes are automatically added to a selection stack for

future recall. Selection stacks save up to the last 127 values entered.

[] To activate your selection, touch .5 x.5 on the table of paper sizes; this redraws

the work area 0.5" square.

[] Select circle mode, then touch a point near the center of the work area to set the

center of the circle; no need to be precise - any point will do, so long as a 0.375"

diameter circle will fit the work area. If you ever do need to locate the center

accurately, select Snap Grid, then activate the left-hand grid on the palette.

[] Key in .375, then Enter to draw the circle.

[] Select line mode, then touch the exact center of the circle to set datum (it’s a

snap point, and even if the Points display is off, you will be able to locate it). Key in

F6 (we will usethe word Delta to indicate the F6 key), then the coordinates of the

first corner of the cross-shaped slot, Figure 27. Starting at top right, the

coordinates are .05/2 (X), and .25/2 (Y); press F11 to shift the datum.

(In Figure 27, you’ll see that the Points display is now at top left. All palettes can be

freely positioned. Your preferred palette layout can become the system’s “default”

setting by selecting Save Setup from the Set Up menu.)
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[] Select Orth Trap. Point the cursor down the trap line, key in .25, then Enter to

draw. Now draw left .05, up .25, then right to complete the vertical rectangle (you

don’t need to key in the last side, of course).

[] Draw a horizontal rectangle, same size, same way. Start with Delta, then

.25/2,.05/2, followed by F11.

[] Select Erase - part item, then chop out the 0.05" center square.

[] Switch on the Points display, and check for any handle markers (little

triangles). There should be none, unless you inadvertently selected the triangle

from the elements palette at some stage in the drawing. If there are, Erase them

(Make sure the markers display is selected from the Erase palette). If you have a

handle coincident with other features you wish to retain, touch the handle with

the trap cursor, then touch the other features affected to cancel their removal.
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Figure 27: Drawing a screwhead



[] Select the handle (little triangle) from the elements palette, then touch the snap

point at the exact center of the screwhead.

You have now planted the reference point, or “grab handle” for the time when you

retrieve the screwhead from the library, to insert it in some other drawing. There can

be several handles on a drawing but in a symmetrical figure like this, just one at the

center is usual.

[] File the screwhead in an empty area of the index. To save space, you could use

a smaller box - e.g. 2 units - but it isn’t important, and it certainly won’t affect your

drawing’s “real” dimensions. So far as the CAD system is concerned, it remains

0.375" in diameter, no matter what size its micro-image may appear on the index.

[] Add a label to the drawing, or exit - your choice.

Now that it is filed, you can use that screwhead as many times as you wish, in any

drawing, at any time. First we recover our drawing from Project 1 by loading it from

the library. Load restores the drawing to the work area exactly as it was before you

Filed it. Literally, you can carry on where you left off.

[] Select Load from the Library menu. (There is no need to reselect A-size paper,

because the loaded drawing comes complete with all of its original data.)

[] With the library index now displayed, aim for your Project 1 drawing. When

you’ve lined up the target - the center of the box - the micro-image reverses.

Touch it to execute Load.

[] Enlarge it x2 with Zoom, snapping the zoom cursor to the center of the circles.

[] Select Radial Grid from the Toolkit menu, but don’t activate it yet (if it is

activated, touch the X).

The required setting of the grid gives you 6 (n) radials (at 60 degrees), with snap

points at .25" spacing (r), and a “start angle” (a) of 0 degrees. If you have any other

configuration, return to the default settings (touch the numerical display in question,

then key in the new value, followed by Enter).

[] In line mode, touch the exact center of the drawing (that’s the center of the

concentric circles), to set the grid datum. Now activate the grid by touching the

check.
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[] Select Drag Insert from the Draw menu, then aim for the screwhead on the

library index. The micro-image reverses (target acquisition) when you hit the

handle. (Aim carefully if there are multiple handles.) Touch it to initiate Insert.

Back on the work area, there is a new palette at top right. Don’t worry about that for

the moment, because it’s most likely set as you need.

[] Surprise! The screwhead itself has become the cursor, and you can drag it

freely around the screen - very useful in freehand work, because it allows you to

try different visual effects before committing yourself. The insert handle is a snap

point, which positively locks onto the radial grid (or any other snap feature). Plant

the screwhead at the six locations shown in Figure 28, then exit the insert mode

by touching the [C] on the Insert palette.

[] If you are pressing on to Project 3, leave the drawing on the screen. If not, File

the drawing in the “box” it came from. You will be asked if you wish to overfile

(check says yes).
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Because overfiling replaces the previous file contents with the new, unintentional

overfiling could be unfortunate.

Several transforms are available with Drag Insert. By touching the arrows at left of

the drag-insert palette, you can have the image “straight up” (default), or pointing

right, left, or down. You can also “flip” it to give a mirror image about the horizontal or

vertical axes. None of the transforms will do you any good with the screwhead,

because it’s symmetrical. There is a simple “flip” illustration in Project 3.

Frame Insert, shown in Project 5, provides an unlimited range of transforms, but it

doesn’t show an on-line “bit map” image that can be pushed around the screen. It is

a “blind” plant - literally, an empty frame, which displays an image only when the

insert is executed. (However, you can get a “draggable” bit map, by selecting Drag

mode, after the Frame transforms have been specified.)

SETTING ANGLES PRECISELY

In Accucadd, angles are usually measured clockwise from West, and are usually

rounded for display purposes (only) to the nearest degree. You can change that by

selecting Precision from the Set Up menu, then choosing degrees only,

degrees/minutes, or degrees/minutes/seconds (and other settings), and you can

also specify the angle direction. Regardless of the display, you can always key in an

angle with the desired degree of precision. You can experiment with the Radial Grid:

[] Touch either of the angle display panels on the grid palette, then key in

31d23’45", followed by Enter. Note that we use the ‘d’ key to represent degrees.

[] Select degrees/minutes/seconds from the Precision table, noting the effect on

the angle display.
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DRAWING PROJECT 3

Still have Project 2 on the screen? If not, Load it from the library. Now suppose, in the

middle of a project, you come across the need for another crop of repeat items like

the screw head.

You could, of course, file the Work In Process (as you did at the end of Project 2),

draw the new component, file it, then load the W.I.P. from the library. However, there

is a better way - use the Scratchpad. This is a back-up work area that can be

switched on and off as needed, without affecting the main drawing. It is an

independent “page”, with most of the main work area’s attributes; it can have its own

paper size, can be loaded from the library, filed, inserted to, and so on.

[] Select New Page from the File menu.

[] Set the page paper size to 2" x 2" square, with Orth active. If that size is not in

the list of user sizes, set it up as you did for the screw head drawing in Project 2.

[] Select Points, then Erase any handles that might be there. If no handles, plant

one at the approximate center.

Our objective is to draw a combination nut and washer, Figure 30, which will be

inserted four times into the main drawing.

The washer profile measures 0.05" x 0.9", so you might wish to set a 0.05" Snap Grid

relative to the center handle (first, set the grid spacing, then touch the handle before

activating the grid). In this tutorial we use leading zeroes to help make the decimal

point clear (so you’ll see .35 written as 0.35). When we do this, you can type 0.35

(as written) or .35 (dropping the zero)–either way is fine.

The snap grid will get you going; it’s an easy way to draw the washer. However,

nothing else fits the grid - that’s life - and you might just as well start the professional

way, with keyboard, Delta (F6), and Orth Trap.

[] In line mode, touch the handle (that’s the triangle in Figure 29) to set the datum.

[] Key in Delta, followed by the coordinates of the top right corner of the washer

(.45,.05), then press F11 to shift the datum. Draw the washer using Orth Trap.

Now, set out the rectangular envelope of the nut, ABCD:
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[] Touch the center handle, then key in Delta, then shift the datum to point “A”

(-0.36, 0.05). Now draw ABCD 0.72" x 0.28" using Orth Trap.

[] Draw the two inner verticals (the flats of the nut) using Orth Trap only; touch

point “B”, point the cursor right, key in 0.18, then press F11 to shift the datum.

Now draw down 0.28". Repeat for the other vertical, 0.18" left of “C”.

[] Draw three vertical 0.28" construction lines, FG, HJ and KL, in the same way.

Use Orth and F11 to locate line positions. (FG, KL, and HJ are centered on nut

faces).

[] Draw horizontal 0.72" construction lines, MN, PQ, offsetting them from top and

bottom by 0.04".

If you are wondering what all that was about, we have fixed the locations for six

3-point arcs, which we are about to add.

[] To make things easier, you might like to zoom about 1.8 times, keeping your

drawing more or less centered.

[] Select Points display, then activate the “intersection locator” (Figure 30).

Touch the intersections arrowed in Figure 29, turning them into snap points.

[] Add 3-point arcs, as shown in Figure 30 (touch first one endpoint then the

other, then set the circumference marker to the middle point).
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[] For the 0.375" diameter “bolt” protruding from the top of the nut, start with the

end “J” of the central line, allow the cursor to snap to point “C” of the rectangular

outline (to establish the direction), and then key in 0.375/2 followed by F11. This

shifts the datum to point “R”. Now use Orth Trap to draw RSTU, 0.375" x 0.05".

[] For the left-hand chamfer, touch “T”, then key in Delta, followed by .04,.04;

don’t press F11 to shift - instead, press Enter to draw the line.

[] Repeat at the right-hand end (use -0.04, 0.04), then draw a line between the

chamfers.

[] Use Erase - part item to trim the chamfers; Erase the construction lines, then

File the drawing in an empty box on the library index.

By now you have probably forgotten it, but your Project 2 drawing is still in the main

work area - unless someone yanked the power cord, or something else killed off the

computer’s on-line memory (RAM). But the drawing is also on disk, so no problem.

[] Select Page 1 from the Window menu.
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Figure 30: Completed nut and washer
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[] Select Snap Grid, then set it to 0.25". Set datum for the grid by touching the

exact center of the drawing, then activate the right-hand grid.

[] Select Drag Insert, then retrieve the nut/washer drawing from the library.

Check the insert palette: if it isn’t in the default state, with the “straight up” arrow

active, make it so.

[] Plant the two upper inserts as shown in Figure 31, snapping the insert handle to

the appropriate grid point.

[] Invert the image by touching the “down” arrow, then plant the two lower inserts.

[] File the completed drawing back to the same box on the library index - that’s the

box the main drawing came out of, not the nut/washer drawing. We use the main

drawing again in Project 5.
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DRAWING PROJECT 4

Here, we take a breather. This is a “party piece” project you can do in less than 10

minutes with RoboCAD, provided you haven’t skipped any of the preceding tutorial.

(To make a neat job of it by traditional methods would take over an hour of heroic

labor.)

[] Wipe the screen, and ensure your settings are correct. Turn on the “right-hand”

screen centered grid, with spacing of 0.25” as shown in Figure 32. This grid has

screen center “cross hairs” to guide you. You’ll also find it easier if you make sure

the trap points display is “on”.Draw a 4" diameter circle, left of center

[] With 4" center-to-center, draw a 2.5" circle to the right. Set its center position by

first selecting line; touch the first center, stretch to the right, horizontally along the

grid, then key in 4 and press Enter. This draws a 4” construction line.
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[] After drawing the second circle, erase the construction line.

[] Select Tangent from the Toolkit menu.

The Tangent palette, Figure 32, offers two choices; (1) point to circle or arc, and (2)

between two circles or arcs. Select 2. (Accucadd can draw tangents automatically,

but for the purposes of this exercise we will not use that feature).

[] Trap the circumference of one circle, then the other.

[] Turn on the Points display (if you didn’t earlier), then draw the external

tangents, as Figure 32.

Now we can use the polar coordinate version of Delta to draw radials. Press the F8

function key. Throughout the remainder of the tutorial, this action will be referred to

as Polar.
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Figure 33: Drawing radials with the polar command



[] Set datum by touching the center of the left-hand circle; key in Polar, followed

by .75,90 then Enter to draw the vertical radial, as Figure 33 (the first entry, .75 is

length in inches, and 90 is the number of degrees clockwise rotation from West.

[] Touch the center of the circle again (to reset the datum there), then key in

Polar, followed by .75,210, then Enter.

[] Draw the third radial in the same way, keying in .75,330.

We don’t do it here, but with Polar - just like Delta - you can use F11 instead of Enter

to shift the datum without drawing a line. If you were doing this yourself, and knew

that the first line was vertical (90) but were not sure about the other two angles, then:

you know that there are 360 degrees in a circle; there are three lines, so

the spacing is 360 / 3 or 120. Key in (.75, 90), (.75, 90-120), and (.75,

90+120) and let Accucadd do the figuring for you!
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[] Select circle, touch the end of one of the radials, then set the circle diameter by

keying in .375, followed by Enter.

[] Plant 0.375" diameter circles on the other two radials.

[] Draw concentric 0.625" diameter circles on the three radials.

[] Concentric with the 4" circle, draw circles with 0.375", 0.5", and 3.625"

diameters.

[] Concentric with the 2.5" circle, draw circles with 0.375", 0.5", and 2.125"

diameters.

[] Select Erase, then remove the three radials (yes, you can get them all in one

shot - aim for the center).

[] Select Fillet, then set the fillet radius to 0.625"; fillet the three “radial” circles, as

Figure 34. (Accucadd has an automatic fillet-and-trim function, but we don’t use

that here).
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Figure 35: Cross to be inserted as a center marker



[] Use Erase - part item to remove the inner segments from the radial circles.

[] Select Hatch, then use any pattern with 0.1" pitch to fill the outline as shown in

Figure 36.

[] Select Edit: Change - part item, then convert the “belt” round the “pulleys” to

line weight 2 or 3.

[] Select New Page from the File menu. If Page 2 is already in use, use Page 2

from the Window menu, and Wipe it. Set the paper size to 0.5" x 0.5". Draw the

cross shown in Figure 35. It measures 0.2" x 0.2" (end-to-end). Plant a handle at

the center of the cross, then File it.

[] Return to the Page 1, then use Drag Insert to plant a cross at the center of all

five circles, as Figure 36. File the drawing when finished.
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DRAWING PROJECT 5

Here we look at some new ways of handling inserts. We will use the same drawing

we completed in Project 3.

[] Load the drawing from the library, then Zoom to enlarge it x2.

[] Select Erase, then touch the circumference of one of the screw heads with the

rectangular trap cursor.

Interesting, isn’t it ? The system can’t find an element there. That’s because an

inserted drawing is treated as a single element, i.e. an indivisible entity.

[] Now touch one of the insert handles. This time there is no warning beep, the

symbol is outlined (if the markers are on), and, when you touch the check, the

entire insert disappears.
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Figure 5-1: Project 3, enlarged X2



You can repair the damage using Undo, or you can use Copy to re-draw it, without

going back to the library:

[] Select Radial Grid, then set it centrally by touching the center of the figure

before switching on the grid. Use r = 0.25", and n = 6.

[] Select Copy from the Draw menu. To use Copy, touch the handle of one of the

surviving elements and touch the check symbol. Select Drag from the resulting

menu. Now, touch on the same insert handle to specify the point by which to

Drag the insert. Plant the image in the place recently vacated, then touch [C] to

cancel Copy.

Once planted, an inserted element can be moved, and also changed in size and

shape at the same time.

[] Select Move from the Edit menu, then touch one of the screw heads. Use this

command the same way as the Copy command. Steer the image to some new

location, then plant it. You can keep moving it around until the desired effect is

achieved (in this case, however, you will probably wish to return it to the spot it

came from). Exit the Move mode by touching the [C].

Well, so far, inserts can be planted, copied, erased, and moved. But it would be very

useful if you could get inside an insert, then edit it as though it were freshly drawn

data. You can, by Exploding it.

Now, suppose the two uppermost nuts and washers should really have been bolt

heads, with washers twice as thick (0.1")...

We can come up with the bolt heads - and save a lot of work in the process - by

modifying our nut/washer inserts, but first we have to raise them by 0.05" to double

the washer thickness.

[] Still in the x2 zoomed view, turn off the Radial Grid, then select Orth Trap.

[] Select Move and touch the handle of one of the upper inserts. This will tag the

insert, the centerline, and the top line of the object. Touch the centerline and the

top line of the object to deselect them. Touch the check symbol and select Offset.

Touch the insert handle and point the cursor up the Orth trap; then key in .05

followed by ENTER to move the nut and washer.

[] Repeat for the other upper insert.

Accucadd Quickstart

Page 5-2



[] Zoom more on one of the inserts, as Figure 39. Select Explode, then touch the

insert handle. After the “explosion” is completed, the + cursor is returned.

[] Select Erase, then remove the three lower arcs, and all other elements you

don’t need. Restore any missing pieces and add .05" to the washer thickness.

[] Repeat for the other insert.

Here’s another typical situation: you realize that a whole family of inserts has to be

modified. In other words, there is something amiss with the library drawing from

which the inserts were cloned. Well, you could always File your main drawing, Load

the “insert original”, fix it, then overfile it in the box it came from. Now, when you Load

your main drawing back to the work area, all occurrences of that insert will have

been modified in the same way.
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However, you’ll be relieved to hear there is a much faster way, one that significantly

reduces the number of library calls. Suppose we wish to add some shading to the

nut/washer insert:

[] Select Isolate from the Edit menu, then touch the handle of one of the two

remaining nut/washer inserts (the ones you exploded are no longer inserts).

Isolate automatically switches the system into Scratchpad mode, with the

appropriate paper size, then loads the selected insert exactly as it was originally

drawn, i.e., it returns a fully editable drawing. In Accucadd, using Isolate is the only

way to get to the Scratchpad - you can’t select it directly.

[] Add vertical Hatch, with 0.05" pitch, to the outer “flats” of the nut, as in Figure

40.

[] File this new nut drawing over the old nut drawing (Update), then re-select the

Page 1 from the Window menu.
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Figure 5-3: From nut to bolt head, using Explode



The main drawing, which will now be redisplayed, shows the changes. All clones of

the nut/washer used in any drawing in the same library will now automatically have

been updated. This is a very powerful feature, known as “global edit”, which you

should use with care.

Now, at last, we come to Frame Insert. It turns out that the bolt heads need holes

through the flats for safety wire. First, we draw and file a small circle, which can be

made into an ellipse using one of the many Insert transforms:

[] Select Page 2, Wipe if necessary, then set the paper size to 0.2" square.

[] Draw a 0.1" diameter circle at the approximate center, then plant a handle at

the center of the circle.

[] File the circle, then re-select the main page.
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FLEXIBLE INSERT HANDLING WITH “FRAME”

As you can see, Frame

gives you many options

for complex transforms.

You can rescale the

insert by any

percentage value - up

or down - relative to its

original size, 100%. For

an insert 10 times larger

than originally drawn,

you would enter

1000%.

You can also stretch the

width, while keeping the

height constant, and

vice versa.

Here is something you should know before getting too far into the frame palette: the

square at top left (the one with a +) signifies location mode “on” or “off”. Fixing the

frame cursor’s location is the first thing you do in the insert process (numbered

procedure below). You are then free to select any of the transform icons in the

column beneath it. As usual in Accucadd, you have the choice of freehand transform

control with the pointer, or precise numerical control by touching the display panel

right of the icon in question.

The open square - left of the check symbol - is the reset button, which restores all

default settings in one shot.
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The insert can be squashed, which

means the frame becomes a

parallelogram, with an “angle of lean”,

i.e. distortion, you can specify. The

more it leans from the vertical, the

squatter it becomes; until, at 90° lean,

the frame vanishes into a horizontal

line. In the squash mode, the vertical (or

once-vertical) sides of the frame are of

constant length regardless of angle.

The insert can also be sheared, another

parallelogram transform like squash. In

shear, however, the height of the frame

remains constant regardless of angle.

What this means, of course, is that the

vertical sides of the frame elongate as

the angle of lean increases.

Between the two, squash and shear,

you should be able to achieve any

short/fat, tall/thin effect you wish.

There’s more. The entire insert, modified in any of the above ways, can be rotated

through any angle. For added variety, you can apply line weight or line type

overrides to all elements in the insert (you can’t be selective). You can view in “real

time” the effect of a frame transform by switching to the drag mode (touch the icon at

bottom right of the palette), while keeping all the frame settings intact. This gives the

now-familiar “draggable” image (i.e. a bit-map). You can freely transition from one

insert mode to the other, at any time.

Cut insert is a feature of Accucadd that removes any elements under an insert after it

has been placed. For instance, if a window is inserted over a wall, the section of wall

under the window would automatically be removed.

In Project 5, we stay away from the more exotic possibilities, confining ourselves to

altering width only. However, if you wish to try it, here is the full procedure.
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1 With the location icon active (i.e., lit), touch the cursor at any point in the work

area. This activates the frame cursor, a dotted rectangular frame you can move

around freely. The + within the frame is the handle you selected for the insert.

2 Steer the frame into position (usually, setting the +to a snap point), then touch

again to fix its location. That done, the handle appears as an inverted triangle.

3 Now you are free to modify the frame. Touch any of the six transform icons, then

touch yet again - anywhere - to activate a second frame cursor. This is the transform

frame; it is “rubber-banded”, and you can control it in size and shape by moving the

pointer.

(Alternatively, you can transfer control to the keyboard by touching the panel right of

the selected icon, then keying in the desired value, followed by Enter to fix the

frame.)

4 With the rubber-banded frame set to your liking, touch again to fix its shape (no

need for this with numerical data entry).

5 Now, finally, draw the insert by touching the check on the frame palette.

Back to Project 5 ... First, we fix locations for the safety-wire holes, marking them

with handles for precise positioning of the inserts:

[] Select line mode and Orth; Zoom on one of the bolt heads.

[] Touch the lower left corner of the

front face, arrowed in Figure 41;

key in Delta followed by .18,.14,

then F11 to shift the datum. Plant a

handle there.

[] Revert to line mode, then locate

the centers of each side face in the

same way. To do this you should

first select Points, then turn off

point-snap. Otherwise, the handle

may snap to an adjacent arc center

instead of the Orth trap datum.

[] Plant handles on the other bolt head in the same way.
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[] Select Frame Insert from the Draw menu, then retrieve the circle you just filed.

[] Touch once - anywhere - to activate the frame cursor.

First, we plant an unmodified insert on the front face:

[] Steer the frame cursor over to one of the bolt heads, then snap the + to the

middle handle, Figure 42. Touch again to fix the insert’s location.

[] Draw the insert by touching the check on the frame palette. Now, we transform

the insert:

[] Touch again - anywhere - to reactivate the frame cursor, then snap the + to the

handle on the left “side face”, as Figure 43. Touch, again, to fix the insert’s

location there.

[] Touch the display panel right of the “width” (X scale) icon on the frame palette,

then key in 50, followed by Enter.
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The dotted frame shrinks to half-width, and the insert it carries (invisibly) is similarly

modified. The result of squeezing the circle is a perfect ellipse, which you can verify

later by using Zoom.

[] Draw the insert by touching the check on the frame palette, then draw a second

ellipse on the other “side face”.

[] Touch [C] to exit the Frame Insert mode. Redraw, then Zoom again, but this

time to a magnification that includes both bolt heads in the one view. Erase the

unchanged bolt head.

[] Select the Copy function, select the new bolt head, then select Frame from the

resulting palette. Place the copy of the bolt head and touch [C] to exit.
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[] File the completed drawing in the index box it came from, at the end of Project

3. Now you can Load it back again, to check the effect of additions made using

Isolate, Figure 40
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DRAWING PROJECT 6

In this project we will draw two electronic symbols, then assemble them into a simple

schematic. The assembly part of the process is nothing more than a space planning

exercise, identical in concept to drawing a furniture outline, then inserting it in a floor

plan. (After this project, you could try drawing the desk you are sitting at, then see

how it looks at different locations in a plan of the room.)

Remember that it is good practice to draw the component outline on a “paper size”

just large enough to accommodate it. This gives a more identifiable micro-image on

the library index.

[] Wipe the screen, or Reset, then set the Paper Size to 1" x 1".

[] Draw a 0.9" diameter circle in the center.
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Figure 45: Drawing a transistor symbol



[] Select Snap Grid, then set the grid spacing to 0.05". Touch the center of the

circle (grid datum), then turn on the right-hand grid.

A new element, Nib, is used to draw the vertical rulings. In this case, we select a

spacing (pitch) so that the nib will print as a solid. In other applications, especially

graphic arts, Nib can be set with other spacings, line weights and line types to

generate a variety of dramatic effects.

[] Touch the Nib icon at bottom left of the elements palette. Check that the line

spacing, displayed just below the nib icon is 0.01". If not, touch the numerical

display, then key in .01, followed by Enter.

[] With the + cursor, touch the grid point 0.15" (3 units) left of, and 0.25" (5 units)

up from center. Now move down 0.5" (10 units), and touch again. Move left 0.05"

(1 unit), touch, then move up 0.5" and touch to draw the nib.

[] Back in line mode, locate the grid point 0.2" (4 units) right of, and 0.4" (8 units)

up from center. Draw AB, then repeat for CD as in Figure 45.

[] Select Arrow from the Dimension menu, then touch the numerical display that

appears on screen, key in .1, followed by Enter.

The arrow is normally part of a dimension label and its length is relative to text

height, i.e. it is not measured in absolute terms. Although there is no text here,

you will find that a “text height” of 0.1" draws the right size of arrow for the job.

[] Steer the “trap” cursor over the line CD, nearer C than D, then touch to draw.

Exit the Arrow mode by touching [C].

[] Erase the center handle, and any construction lines, then plant handles at

points A, D and E. (These are the end-points you will be wiring up to.) File the

transistor in an empty box in the library and Wipe the screen.

Now for another symbol, a resistor.

[] Using the same 0.05" grid as before, draw the resistor symbol then plant a

handle at each end, as Figure 46.

[] File the resistor in an empty box.

The handles you planted on the transistor and resistor drawings were either 8 or 16

grid units apart, along the horizontal and vertical axes. This is not a coincidence; it

makes the job of inserting them in a schematic, and connecting them together, that
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much easier. Why? Because on your large-size schematic, you will be using a 0.4"

grid, i.e. 8 times larger than the grid you drew the symbols on. You don’t have to stick

slavishly to these numbers, but you should understand the basic idea.

[] Wipe the screen, then change the Paper Size to B (11" x 17").
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Figure 46: Drawing a resistor symbol



[] Select Snap Grid (right-hand icon), set the spacing to 0.4", then turn on the grid.

[] Select Drag Insert, then acquire the transistor from the library. Plant transistors

1 and 2, Figure 47.

[] Still in the drag mode, “flip” the insert about the vertical (Y) axis by touching the

icon highlighted in Figure 47. (The other icon with two arrows is for X axis flip).

Plant transistors 3 and 4.

[] Exit the drag mode by touching [C].
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[] Re-select Drag Insert, then acquire the resistor from the library. Plant resistors

as in Figure 48.

[] Exit the drag mode, then use lines to connect the symbols. Draw small circles

to denote wire joins, if you wish.

If you need more clones of the resistor or transistor, there is no need to go back to the

library, use Copy. Also, you can use Move if you happen to plant a symbol in the

wrong place.
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DRAWING PROJECT 7

The dimensioning utility in Accucadd automatically measures and annotates any

feature of a drawing, adding internally generated extension lines, dimension lines,

and arrowheads.

In this project we turn to that perennial favorite, the widget, Figure 7-1. What follows

is intended to illustrate dimensioning capabilities, rather than exemplify good

drafting practice (in real life you would avoid such an array of dimensioning styles).

Watch out for two or three new drawing methods introduced along the way.

[] Set Paper Size to 5" x 4", then select line weight #2.

[] Draw a circle 0.875" diameter, 1" left of, and 0.5" above the screen center.

[] Turn on Orth Trap, then select compass arc from the elements palette

(highlighted in the elements palette shown in Figure 7-1).
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[] Fix the arc center by touching the center of the circle.

Touching the center also plants the Orth Trap datum there, which is handy, because

you can slide the “radius cursor” (+) along it. (Sliding along an angle trap - such as

Orth - is one way of initializing the arc; another way is to snap the + to a grid point, or

the end-point of an element.)

[] With the + sitting on the horizontal trap line, left of the circle center, key in .75,

followed by Enter. This snaps the start radius to point A.

You can now sweep the arc in either direction from the start radius by moving the

pointer (a touch would draw the arc, if you were working freehand). We need a

sweep angle of exactly 120 degrees.

[] Key in 120, followed by Enter to draw the arc AB. (If you were to key in -120, the

arc would drawn in the other direction.)

To draw BC, we use an angle trap tangential to the arc at point B:
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[] Select line mode, then select Angle Trap from the Toolkit menu; this displays

an angle palette at top left of screen, Figure 7-2.

There are two basic angle traps: absolute, measured clockwise from West; and

relative, measured clockwise relative to a selected line or arc end-point. The angle

trap datum can either “update” (i.e. follow the drawing around), or remain “static”.

Six angles are listed, but only three traps can be set any one time.

[] On the angle palette, set angle A to 0°, and C to 90°, by touching the numerical

display, then keying in the desired value. “Arm” the trap by touching A and C.

[] Touch the updating and relative icons, highlighted in the palette in Figure 7-2,

then activate the trap by touching the check.

[] Select Arc direction from the Toolkit menu, then touch the arc near point “B”

with the rectangular cursor. This will display a tangent (0°) and normal (90°) trap,

as Figure 7-2. (You may first have to touch point “B” to reset the trap datum.)

[] Draw BC, 2.5" long (touch “B”, point toward “C”, then key in 2.5, Enter).

[] Draw CD (0.750"), DE (full width) and AF (0.625"), using Orth Trap. DE isn’t

specified, so make sure it is long enough to intersect the line from “F” (at “H”).

[] Reselect Angle Trap. Turn angles A and C off, and B on ( Make sure it is set to

60°). Touch the absolute icon, left of the relative icon. Now touch point “F” to set

the datum there, then touch the check to activate the trap.

[] Draw FG, to any length beyond the intersection, then trim the surplus from both

intersecting lines using Erase - part item.

[] In line weight 1, use Orth Trap to draw the horizontal line CJ; this is the datum

used for measuring the angle of line BC.

[] Use Drag Insert to plant a 0.2" cross at the center of the circle. (This is the

center mark from Project 4.)

Before we dimension anything, we need also to set the measurement precision, i.e.

the number of digits following the decimal point. In the default state, which we leave

in effect here, the system rounds off length measurements to three digits, and

angles to degrees only. (If you wish to change this, select Precision from the Set Up

menu.)
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Adding dimensions to the widget is remarkably easy. Three

dimensioning “standards” are available in Accucadd: these

are ANSI, ISO, and BS308. You can also decide for yourself

how the dimensioning will appear:

[] Dimensioning specifications can be set by selecting

Setup from the Dimension menu. This selection includes

many additional user adjustable variables. The radius and

diameter dimensioning functions add center marks

automatically.

For this example we suggest the following settings: line

broken, 0.05" offset, closed arrow, and 0.1" text.

[] Change the dimension specifications and precision if

you wish

[] Select Line from the Dimension menu; touch the overall

length, horizontal label, centered label, and single line

icons, as in Figure 7-4.

The Tol icon, which we don’t use in this project,

allows you to manually enter tolerances, which

are added to the measured dimension.

Tolerances can be entered in three ways:

absolute + value, separate positive and negative

values (+/-), or absolute maximum and minimum

values.

[] Touch point B, then C.

This gives you a complete, moveable kit of

extension and dimension lines, arrows, and text

label. The “+” behaves just like the regular

drawing cursor, i.e. it will attach itself to any snap

point, including any dimension arrow - very useful

for chain dimensions.

[] Plant the “dimension set” as Figure 7-5, then

touch to confirm.
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[] Touch the vertical projection icon, then dimension CD.

The sweep of an arc is dimensioned with the Angle command and circles are

dimensioned with the Radius command, both within the Dimension menu.

[] Select Angle from the Dimension menu, then touch the angle and horizontal

label icons.

[] Touch the arc AB - anywhere - with the rectangular cursor, then move away to

set the dimension arc as Figure 7-6, snapping the + cursor to the dimension

arrow at B. Touch to confirm. If not already placed, set the text cursor in position,

then touch again to draw the text.

[] Select Dimension:Radius and select the arc radius icon. Touch the arc again.

Pull the radial line out to the desired length, then touch to confirm. If the text has

not been planted, set the text cursor in position, then touch again to draw.

Circle diameter is measured in a similar way to radius of arc:
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[] Touch the diameter icon then touch the circle with the cursor, then complete

the dimensioning as Figure 7-6.

[] Select Angle from the Dimensions menu and touch the angle icon as in Figure

7-7. Touch points B, C, J, in that order, then enter the measurement. (Use the

“free” label mode, if you prefer.)

[] Reselect Distance, then dimension lines AF and FE, using vertical and

horizontal projection, as appropriate.

Measuring FE, you will have noticed that the system itself determines whether the

arrows should point out (standard condition), or in (inverted), depending on text

height relative to size of measured feature.

Arrows, dimension lines, extension lines and labels are, for the most part, standard

drawing elements, and can be edited in the usual way, although the Undo command

will remove an entire dimension. The dimension elements are assigned unique line

weights, which allows you to control how they print, independently of the rest of the
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drawing. The dimension label is entered in weight B, and everything else in the

“dimension set” is in weight A.

One last note on the dimensioning system: if the dimension, as measured, is not

what you wish to enter, simply touch the measurement display panel, then key in

your “override” dimension (without units).
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Also, Accucadd allows a Prefix and Suffix to be added to the dimension text.
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DRAWING PROJECT 8

This project illustrates an alternative way of setting out a drawing, one which many

designers find efficient. You may, too, depending on the form of your raw data -

model, sketch, numerical data, or just an idea in the mind’s eye. Basically, this

method has you setting out a series of coordinates, then “joining up the dots” with

lines and circular arcs.

[] Reset the system to the settings shown in figure 58. Orth trap is optional for this

project.

Leave the Points display on. Make sure the paper size is A (8.5 X 11).

[] Place a handle at the center of the

page if there is not one already there.

For this project, we will use the Coords

key (F5) to enter coordinates.

[] On the keyboard, press Coords,

and key in 0,-2.1, followed by Enter

(this is for point “a” in the list below).

This plants a snap point at X0, Y-2.1,

relative to the last handle entered–in this

case the handle that was placed in the

center of the paper.

[] Now enter the other snap points

the same way, in any order.

(a) 0,-2.1 (g) 0.4,-0.07

(b) 0,-0.07 (h) 0.4,-2.1

(c) 0,3.6 (j) 0.23,1

(d) 0.4,3.6 (k) 0.23,2.3

(e) 0.8,3.3 (o) 0,0

(f) 0.4,0
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A WORD ON KEYBOARD DATA ENTRY...

In Accucadd, the special keyboard entry features described below are activated by pressing

function keys:

Coords is enacted by pressing F5

Delta is enacted by pressing F6

Polar is enacted by pressing F7

Polar offset is enacted by pressing F8

Either Coords or Delta can be used to relate one point to another, as specified by a pair of

coordinates. They are related functions, but with a specific difference:

Coords relates to the last handle drawn on the screen (the center, if you haven’t planted

others). Also, Coords plants a “findable” snap point, removable only by wiping the screen or

loading another drawing; Coords doesn’t draw lines.

Delta relates to the last datum, the last location “touched” by clicking the mouse. Delta will

either shift datum (“update” it) to the new location, if you press F11, or draw a line to it if you

press Enter.

Polar is the polar equivalent of Coords–use (distance, angle) in place of (x,y).

Polar offset is the polar equivalent of Delta–again, use (distance, angle) in place of (x,y).

[] In line mode, draw from a to c, then touch the tangent arc icon at bottom right of

the elements palette (highlighted in Figure 58). Set the arc center (+) to the snap

point at d, then touch to confirm. Sweep the arc clockwise to see how it will look,

then key in 220, followed by Enter to draw the arc. (You could just as well do this

freehand - the sweep isn’t critical, so long as it intersects with the circle at e,

which you draw next.)

[] Draw a 0.4" diameter circle at e.

[] Select Toolkit: Tangent, option 1 (point, circle); touch the circle with the

rectangular cursor, then point f with the + cursor.

[] In line mode, draw from f to the newly-found tangent point.

[] Draw o-f, then b-g.

[] Draw from f to h. Select blending arc, then draw from h to a.

Blending arc is similar to the tangent arc centered on d. Both are smooth

continuations of a previously drawn feature, which may be either a straight line, or
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another arc. However, with tangent arc, you specify radius and sweep angle

separately; with blending arc, on the other hand, you aim for an end-point, leaving

the system to calculate its center, radius and sweep angle.

Note that you now have a new snap point–the center of the arc you just drew. Call

this point m–you’ll need it in a moment.

[] Select Erase, part item; zoom to display the circle at e; trim the surplus arc, and

the larger segment of the circle.

[] Draw 0.25" diameter circles (rivets) at d, and the other two snap points on the

pizza cutter handle, k and j.

[] Select a “square” hatch pattern, with 0.1" pitch, then complete the handle, as

Figure 59.

Now you need to draw the cutting wheel, and the wheel screw.
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[] Select circle, and with point m as the

center draw three circles, Make them

3.8”, 3.6”, and 0.25” in diameter.

[] Remember the screw head from

project 2? Use Draw: Frame Insert to get

this from the library. Set the scale to

50%, and plant the screw onto point m.

[] Zoom centered on the screen center,

and using Erase: Part Item trim the two

parts of the circle that are “behind” the

handle, as in figure 59.

[] File your drawing in the library - we’ll

be using it again later.
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DRAWING PROJECT 9

This project introduces isometric drawing, using a “skewed” grid, that is, a grid with

one of its axes rotated through 30°.

[] Reset the system (see figure 60), then select Snap Grid.

[] Set the grid spacing to 0.25", if necessary, then change the 0° angle display

(just below the two grid icons, arrowed in Figure 60) to 30°.

[] Activate the grid (right-hand icon), select line weight 2, then draw the outline as

in Figure .

[] In line weight 1, and a dotted line-type of your choice, add the four

parallelograms, with center lines, to define the major and minor axes of the
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ellipses you are about to draw. (With practice you will find you can do without

these constructions most of the time.)

[] Re-select line weight 2 and the continuous line style.

[] Zoom if you wish, as Figure 61. Select Toolkit: Line Direction, touch point A,

followed by point B (this procedure sets the start position and direction of the

tangent arc), then select tangent arc from the elements palette.

[] Snap the end of the arc to C, then to D, then to E, finally completing the ellipse

at B.
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[] Still with the arc selected, again select Line Direction from the Toolkit menu.

Touch F, followed by G, then draw the second ellipse as Figure 62. (You need

only three arcs this time.)

[] Draw ellipses on the horizontal surface in the same way.

[] Erase the construction lines, then trim the ellipses using Erase - part item.
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[] File the completed drawing, as Figure 63.

The dimensions in figure 60 are for your information only: drawing them is not part of

this exercise. Note, however, that Accucadd provides automatic isometric

dimensioning–the dimension text is “twisted” into the isometric plane, and the

dimensioning lines are also in the isometric plane.

If you wish to experiment with isometric

dimensions, you’ll need to know which icons

control the isometric plane selection. These are

shown in figure 64. Select from the upper two

for “horizontal” or “vertical” direction. Select

which of the three isometric planes by using one

of the lower three icons. There is a total of six

combinations.

For full information see the Accucadd

Reference Manual, Dimensioning.
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DRAWING PROJECT 10

This project brings together many of the basic drawing techniques sampled in the

previous illustrations. The objective is to sketch a pair of lineman’s pliers, based on

the dimensioned drawing shown below. If you’ve worked carefully through the

earlier projects, there will be nothing in the pliers you can’t handle.

Some pointers ...

� Use a “loose” style of drawing, entering lines and arcs oversize, by the easiest
method available; then trim using Part Erase.

� Draw one half of the pliers, file it, then use Drag Insert to flip it. Use Explode to
remove unwanted features (or you can use the Copy command to avoid
having to file, insert, and explode).

� Construct an envelope for the crosshatch on the handle by drawing a third
3.7" arc (dotted, in Figure 65), centered midway between the other two. Draw
the horizontal construction line AB, then round the envelope by filleting AB
and the dotted arc. Draw the hatch, with 0.08" spacing, then erase the
envelope.

� For the serrations, draw a 0.48" diameter construction circle as shown, then
zoom. Set a radial grid with n = 48, and r = 0.02". (This is a closely-spaced
grid; to display it you will need a magnification of approximately x22.)

� The dimensioned drawing (figure 65, below) was done on an A-size page,
using 0.1" text.
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COLORS AND LAYERS

Layers can be considered as “transparent overlays” on which you can draw in any

color, line weight, and line style. Accucadd provides 1,000 different layers. Layers

are a means of grouping classes of data in a drawing. In a building design, for

instance, you might draw the outline on one layer, the electrical layout on another,

plumbing on a third, and so on.

On the status bar at the bottom of the screen, there are two boxes right of the prompt

area. The first box indicates the Active Layer Number - which layer you are currently

drawing on - and the second box either reads ‘A’ or displays a number that indicates

that the active layer has been restricted to a single color. The number is the Color

Number.

[] To change the active layer, touch the Active Layer Number box. This displays a

window or dialog requesting a new active layer. Type in 0 and press Enter.

(You can use either the

layer number, 0 in this

case, or the name. For

now we’ l l only use

numbers).

To change the layer settings use Set Up: Layer Table. This shows the Layer Table

editor window (below). The Color entry in the window shows whether you can draw

on that layer in only one color, given by its color number, or any color, indicated by

‘A’. You’ll see that layer 3 is set to color 3, while all the other layers are set to A - all

colors allowed. You’ll also see that only 12 layers are displayed. Layers that aren’t

set up are not displayed. You can add or remove layers at any time. If more layers

are set up than will fit in the box you’ll see a scroll bar on the right side of the window.

The Line Style (LS) and Line Weight (LW) entries operate similarly (1-8 or A). The
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columns headed A and C are for Attributes and CNC work, which we will not go into

in this tutorial. You can ignore them.

The Display entry shows whether the layer is displayed or not, and which layer is the

Active one (the only layer you can draw on, usually).

[] To change the current color, assuming it is set to “A” (any color) for this layer,

touch the color entry for that layer (in the color column), and note that the color

name highlights. Under the list of layers, click the “All” colors check box

twice–once to select it, a second time to clear the check. Then either click in the

text box and type in a color number, or touch the color box and pick a color from

the window. When you have selected a color, the new color number will show in

the text box. If it is correct, touch the Apply button. If you do not touch Apply,

nothing will change–handy if you made a mistake.

[] You change the other parameters in the same way. Touch to select the layer,

make the changes in the Display, Color, LSTYLE, and LWidth groups under the
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layer table properties display, then touch Apply. To return to drawing touch OK or

Cancel.

[] To re-name a layer, select it then use the Layer Name edit box. (You can’t

change the layer number).

When using Drag or Frame Insert to add an item from the library to a drawing, you

have a choice of how the layering will behave. After selecting insert, you’ll see the

layer number box will read “OFF”. With this setting, the inserted data will keep its

original layer structure. If you over-ride this, and set an active layer, then all the data

in the insert will be “forced” onto that layer, taking on the color and line style

over-rides too, if they are set. To change the layer of anything you have drawn you

can use Edit: Change.
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PRINTING

SCALE PRINTING

[] Load any drawing to the screen, or draw new material, then select Print from

the File menu.

You can use the Layer Table Display control and the View: Speed Filter menu item

to control printing of any layer(s) or listed components of the drawing.

VIEWPRINT

You also have the option to print the current view. This will not be to scale unless it is

the base view (you just used Redraw), but you can use zoom and pan to select any

part of your drawing at any size. This option is found in the File menu.

CUT AND PASTE

With Accucadd you can use your Windows’ Print Screen facility to capture the

screen image. This is very useful in documentation. All you have to do is press the

Shift and PrtSc keys, and the entire screen will be copied to the Windows clip board.

To use the captured image, simply paste it into another application (using that

application’s Edit: Paste menu item or the Ctrl-V key combination). For example, to

put it into Paint for editing, open the Paint program, and press Ctrl-V. To paste into

Word, do the same. You can use Zoom to display part of your drawing, and then use

PrtSc, if you wish.

It sounds easy, is easy, and is very useful for proof copy. Its key advantage is that it

takes no time at all to capture the screen, regardless of complexity. However, PrtSc

has its problems, the main one being that it prints the image exactly as it appears on

the screen, warts and all. The image reproduces faithfully the “jaggies” caused by

limited resolution.

To copy a high resolution (technically a vector Windows Meta File or WMF) copy of

the drawing itself to the clipboard you have two options in Accucadd. Use either:

� Clipboard: Metafile–places the drawing data only (lines, arcs, text, etc.)
onto the Windows clip board. The format is WMF which is universally
supported in Windows applications.
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� Clipboard: Drawing Data–places the drawing data as above, but in a frame
representing the sheet of paper you are using. The format is WMF as
above, but tagged as an Accucadd drawing. This means that if you paste it
into (say) a Word document, then double-click the picture in Word,
Accucadd will automatically open with that drawing loaded for editing.

These WMF drawings are scalable without losing resolution.

WINDOWS PRINTING and ACCUCADD

Unlike previous (RoboCAD) products, Windows, and not Accucadd, controls the

printing (and plotting) of your drawing.

Accucadd is a 32-bit Windows program, and it uses Windows printers and printer

drivers. This means that it is inherently compatible with all Windows printers. It also

means that it does not use RoboCAD Plotter and Printer descriptor files (drivers) -

the PLT and PRT files. As a quick check, if you can print something from WordPad

(or Microsoft Word), then you can print to that same printer with Accucadd.

Conversely, if you can’t print to the printer from WordPad, you won’t be able to print

from Accucadd either, and that’s a Windows printer problem, not an Accucadd

problem.

If you are not printing to a color printer, you can have all Accucadd drawing elements

(lines, arcs, etc.) print as black, or (if supported by your printer and printer driver) in

shades of gray approximating the color brightness. Most monochrome printers will

support about 32 shades of gray.

If you are printing to a color printer, you can print Accucadd drawing elements in the

same color as they appear on-screen. Windows does not offer built-in color

matching, so you may not get the exact same shade of color: however, green should

print green, red should print red, and so on.

Notice that the Print dialog (below) has an RGB check box. With RGB checked, you

will get shades of gray on a monochrome printer, and colors following the screen on

a color printer. This also means that white (and very light gray) won’t print on most

printers: you will not see a white line that you have drawn over a darker background -

the white line will not print.

With RGB unchecked, all colors will print black on a monochrome printer. On a color

printer most colors will be as they are on the screen, except that white (and very light

gray) will print as black.
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Accucadd Printer Colors Dialog

Box

The Printer Colors dialog box appears

when you click the Colors button on the

Print dialog. The results are different

on color and monochrome printers, as

you would expect. Click the Print

button on this dialog to see how your

printer/plotter (technically the driver

and printer in combination) renders

screen colors.

To check how your printer renders

Accucadd colors, click on the Print

button of the Accucadd Printer Colors

dialog.

Color printers

The colors generally print in a similar

tone to the screen color—green

on-screen will print as green, red

on-screen will print as red, and so on.

Don’t expect precise color matching -

Windows does not support it. If your

printed output matches your screen

color exactly this is a (fortunate) coincidence. With RGB checked, you will often get

better color rendering. However, Accucadd color 7 (white) will print white—lines

drawn in color 7 will therefore not print. This is also true of very light grays.

Monochrome printers

If you have a monochrome printer, you won’t see the Printer Color dialog colors

unless you also check the RGB check box. With RGB checked, most monochrome

printers will render the 256 Accucadd colors as approximately 32 shades of gray, but

white and light gray will not generally print, as noted above. With RGB unchecked

(cleared), every one of the 256 colors will print as black.

Linestyles

Checking the Windows Linestyles box on the print dialog converts Accucadd

Linestyles to Windows Linestyles. There are only six Windows Linestyles, so there

is some loss of quality. However, all printers can (or are supposed to) print Windows
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Linestyles. By not checking this box, Accucadd will try and reproduce all of its eight

linestyles on the printer. This will work in most cases.

Lineweights

Clicking the Lineweights button on the Print

dialog pops up the Printer Lineweights

dialog, below. Checking the Use Windows

Lineweights box makes Accucadd convert

its lineweights to Windows lineweights.

These match the default values of the

Accucadd lineweights (below). If you want to

use different lineweights, uncheck this box

and enter values for each Accucadd

lineweight number (1 - 8 and A, B) that you

wish to change. As with RoboCAD 20, the

l ine widths are always speci f ied in

millimeters - as also are drafting pens and

pencils.
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